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Solid Problem Seven 
 

 
In this chapter, you will learn the following to World Class standards: 

 
 Sketch of Solid Problem Seven 
 Starting a 3D part drawing 
 Modifying UCS settings 
 Drawing a closed polyline shape to be extruded 
 Adding circles to the detail 
 Moving the circle inside the polyline 
 Extruding solids from a closed polyline and circle 
 Subtracting a 3D solid from another solid 
 Rotating a 3D solid using the 3D Rotate command 
 Drawing a solid box 
 Moving a 3D solid 
 Constructing a solid perimeter using the Line command 
 Creating polylines using the Edit Polyline tool 
 Extruding a solid from a closed polyline 
 Aligning a solid to the master solid 
 Subtracting 3D solids from the master solid 
 Hiding the solid 
 Moving solid to the origin point 
 Saving the Solid Problem 
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Sketch of Solid Problem Seven 
________________________________________________________ 
 
You start the seventh solids problem with a rough sketch showing the dimensions of each 
detail. This part is symmetrical across the X axis. In this exercise, you will draw closed 
polylines that contain the most complex shape of the component and then use simple 
geometric solids to subtract detail from the extruded master solid.  In problem seven, the 
master solid contains a chamfer drawn into the polyline shape.  You will place a circle near 
the edge of the main shape. After extruding the polyline and circular solids, you will subtract 
the cylinder. You will finish by subtracting a box and a wedge shape from the master solid to 
end with the product as shown in Figure 8.1. 
 

 
Figure 8.1 – Problem Seven Sketch
 
Remember, when you receive a sketch from a professional, quickly identify the different 
shapes and decide how to begin the drawing. Problem Seven has an angled cut on the top, so 
you will create a special prism that you will move and rotate using the Align command, and 
then subtract from the master solid.  All of the drills in the Fundamentals of 3D Drawing 
textbook will walk you through such common repetitive maneuvers that you will use often in 
3D modeling. 
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Starting a 3D Part Drawing 
________________________________________________________ 
 
You will draw Problem Seven using the Mechanical template.  First select the New 
tool on the Quick Access Toolbar. A list of templates is loaded in the “Select 
template” window.  Scroll down the list and select Mechanical.dwt. A new drawing 
file will open that contains the system variables and layer definitions which you will 
use later in Paper Space to finish the drawing. 
 

 
 

Figure 8.2 – Starting the drawing using the Mechanical template 
 
 
 

Modifying UCS Settings 
________________________________________________________ 
 
You may notice the UCS icon moving on the graphical display as you zoom or pan your view.  
If so, the UCS is currently representing the origin (0,0,0) of the drawing area.  This can 
sometimes be distracting, especially if the origin happens to lie in the vicinity of your 
drawing.  You can change the UCS settings so that the icon is always displayed in the bottom 
left-hand corner of the drawing area. Select the Show UCS Icon tool from the Coordinates 
panel under the Home tab (Figure 8.3) and select the “Show UCS Icon” option (Figure 8.4). 
You also have the choice of keeping the UCS displayed at the origin or turning it off 
completely.    
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Figure 8.3  -  The Coordinates panel Figure 8.4  -  Changing the UCS display 

settings 
 

 
 

Drawing a Closed Polyline Shape to be Extruded 
________________________________________________________ 
 

Select the Polyline tool from the Draw panel and specify a start point in the upper left-
hand corner of the graphical display.  You can see the actual continuous line of data 
you need to specify at the command line in Figure 8.5. 

 
Command: _pline 
Specify start point: 
Current line-width is 0.00 
Specify next point or [Arc/Halfwidth/Length/Undo/Width]:  <Ortho on> 2.75 
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: 2.5 
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: 4.0 
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: 1.25 
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: C 
 
Figure 8.5 – The command line text from the Polyline command 

 
With the Ortho mode “on”, draw a 2.75 unit line downward, a 2.5 line to the right, a 4.0 line 
upward, a 1.25 line to the left, and then type “C” and ENTER to close the polyline. A closed 
shape will appear in the graphical display. Zoom and pan the drawing as necessary to 
maximize the shape on your display.  In Figure 8.6 you can see the step-by-step progression 
of building the polyline with Figure 8.7 showing the final two-dimensional entity.  

 

 

Figure 8.6  – Drawing a series of lines using the Polyline command 
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Notice how simple it was to add the angled 
side of the polyline.  By knowing the 
measurements of all of the other sides of the 
shape and drawing them first, you were able 
to let the program finish the part and calculate 
the angles and distance of this edge when you 
used the Close option of the Polyline 
command.  You will save time whenever you 
can forgo complex and time-consuming 
mathematical computations by letting the 
computer do the work.   

  

Figure 8.7 – The finished polyline 
 

 
 
 

Adding Circles to the Detail 
________________________________________________________ 
 
Select the Circle command on the Draw panel.  Select the endpoint Osnap of the lower 
left-hand corner of the polyline as shown in Figure 8.8.  Type “D” and ENTER when 
the command line prompts you to “specify radius of circle”.  Type 0.5 for the diameter 
and the circle will appear on the corner of the polyline as shown in Figure 8.8. 

 
 
 

 

  

 
  

Figure 8.8  – Selecting the center point Figure 8.9 – The 0.5 diameter circle 
  
  
  

Moving a Circle Inside the Polyline 
________________________________________________________ 
 

Before extruding both the Polyline and the Circle, you should position the circle at a 
more precise location. Use the Move tool on the Modify panel to accomplish the task. 
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Select the Move tool on the Modify panel. 
Pick the circle when prompted to “Select 
Objects” and the command line will respond 
with “1 found”, so hit ENTER to go the 
second part of the command. Next, you need 
to “specify base point or displacement” on 
the graphical display. Pick a base point 
anywhere on the display. Then type 0.5, 0.5 
and hit ENTER.  The circle will move 0.5 
units to the right and 0.5 units up on the 
display as shown in Figure 8.10. 

  
Figure 8.10 – The moved circle  
  
  
  

Extruding Solid from a Closed Polyline and Circle 
________________________________________________________ 
 
Only closed entities like Polylines and Circles can be extruded using this very 
powerful tool on the Modeling panel. You can extrude multiple entities at a time into 
solids with the Extrude command. 
 

  
Figure 8.11 – Southwest view Figure 8.12 – Two extruded entities 
  
Select the Southwest Isometric View on the View panel to change the view as shown in 
Figure 8.11. Select the Extrude tool on the Modeling panel and the command line will prompt 
you to “select objects”. Select both closed shapes and the command line will return with “2 
found”. Hit ENTER to specify the height or path of the solid. Type “3” and ENTER for the 
height of the extrusion. Two complex 3D solids will appear in the graphical display as shown 
in Figure 8.12. 
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Subtracting a 3D Solid from Another Solid 
________________________________________________________ 
 
To remove the cylinder from the master solid, select the Subtract tool on the Solid 
Editing panel.   
  

 

AutoCAD will prompt you to “Select solids 
and regions to subtract from”. Select the 
master solid and the system will respond with 
“1 found”. Hit ENTER and you will be 
prompted to “Select solids and regions to 
subtract”. Pick the cylinder and the command 
line will reply with “1 found”. Hit ENTER 
and the cylinder will disappear from the 
drawing leaving empty space in its place 
inside the master solid as shown in Figure 
8.13. You can check the subtraction by 
selecting the master solid with the cursor; the 
entire solid will be dashed as shown in Figure 
8.13. 

  
Figure 8.13 – Subtracting the cylinder  

  
  
  

Rotating a 3D Solid Using the 3D Rotate Command 
________________________________________________________ 
 

  

Figure 8.14 – Selecting the X axis Figure 8.15 – The rotated solid 
  
Select the 3D Rotate command on the Modify panel. When prompted to “select objects”, 
select the solid and hit ENTER and then select the midpoint Osnap of the bottom edge of the 
front face of the solid as shown in Figure 8.14. You are going to rotate the solid part on the X 
axis, so select the circle that orbits the X axis as shown in Figure 8.14. Specify an angle start 
point, and then with the Ortho mode move the cursor so that the preview outline moves 90 
degrees as shown in Figure 8.15. 
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Drawing a Solid Box 
________________________________________________________ 
 
Select the Box command from the Modeling panel and select a point to the right of the 
master solid as the first corner of the box.  Type L after specifying the corner on the 
graphical display to utilize the Length option of the Box command.   
 

Enter 2.5 for the length of the box, 1.0 for the 
width, and 1.0 also for the height.  The solid 
box will appear in the display to the right of 
the master solid as shown in Figure 8.16 

  
Figure 8.16 – A new box  
 
 
 

Moving a 3D Solid 
________________________________________________________ 
 
The Move command is a three-dimensional function in AutoCAD 2012.  

 

  
Figure 8.17 – The destination point Figure 8.18 – The moved box 
 
To move the box, select the Move tool on the Modify panel.  Pick the new box when 
prompted to select objects and the command line will respond with “1 found”, so hit ENTER.  
Select the midpoint Osnap of the bottom edge of the front face of the new box as the base 
point and select the midpoint Osnap of the bottom edge of the front face of the master solid as 
the destination point as shown in Figure 8.17. The solid box will move as shown in Figure 
8.18.  
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Constructing a Solid Perimeter Using the Line Command 
________________________________________________________ 
 
Now you need to create a right triangle with a 2-inch hypotenuse that you will extrude 
into a solid and eventually subtract from the top of the master solid to create the 
angled detail shown in the sketch.  First change to the Top view using the 3D 
Navigation tool on the View panel under the Home tab.  Then select the Line 
command from the Draw panel.      
 
Start a line to the left of the master solid and with the Ortho mode “On”, draw a line 2.0 units 
to the left. Now you will draw a line using a new technique called polar displacement. Type 
2.0<-45 and a line will appear as shown in Figure 8.19.  
 
Remember that if you are not using Dynamic Input (toggeled on and off on the tray at the 
bottom of your scree) you will need to add the @ symbol before typing 2.0<-45.  The formula 
for this particular entry has 2.0 specifying the length of the line.  The < symbol signifies that 
you are going to enter an angular value, and the -45 is the degree measurement from 0 
degrees, parallel with the X axis. 
 

  
Figure 8.19 – Drawing the 45 degree line Figure 8.20 – Mirroring the line 
 
You will use the Mirror tool on the Modify panel to copy the 45 degree line across the 
midpoint of the 2.0 line. At the prompt to select objects, select the 45 degree line and hit 
ENTER.  “Specify first point of mirror line:” by picking the midpoint Osnap of the horizontal 
2.0 line and “Specify second point of mirror line:” by picking anywhere above or below the 
first point with the Ortho mode “On” as shown in Figure 8.20.  The default to delete the 
source objects is no, so at the prompt “Delete source objects? [Yes/No] <N>:” hit ENTER.  
The 45 degree line will be copied and mirrored across the midde of the horizontal line as 
shown in Figure 8.21. You can either use the Fillet or Trim tool to trim the lines as shown in 
Figure 8.22. 
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Figure 8.21 – The mirrored line Figure 8.22 – The triangle after trimming 
 
 
 

Creating Polylines Using the Edit Polyline Tool 
________________________________________________________ 
 
Use the Edit Polyline tool to merge the three line segments of the triangle together into 
a closed polyline. Select the Edit Polyline tool from the drop-down arrow on the 
Modify panel and the command line will prompt you to “Select polyline or 
[Multiple]:”  
 

Select one of the lines of the triangle and the 
command line will reply with “Object 
selected is not a polyline Do you want to 
turn it into one? <Y>”.  Type Y and 
ENTER, and then the command line will 
prompt you with a number of editing options 
from which to choose.  Type “J” and 
ENTER to choose the Join option.  The 
command line will prompt you to “Select 
objects” so select all of the lines in the 
triangle.  The command line should read “3 
total”. Hit ENTER to join all of the entities 
into a closed shape, and then hit ESCAPE to 
exit the Edit Polyline tool.  

  

Figure 8.23 – The closed polyline, selected  

 
 
 

Extruding a Solid from Closed Polyline 
________________________________________________________ 
 
Only closed entities like Polylines and Circles can be extruded using this very 
powerful tool on the Modeling panel. You can extrude multiple entities at a time into 
solids with the Extrude command. 
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Figure 8.24– Extruding the triangle Figure 8.25 – The new solid prism 
  
Select the Southwest Isometric View on the View panel to change the view as shown in 
Figure 8.24. Select the Extrude tool on the Modeling panel and the command line will prompt 
you to “select objects”. Select the triangle and the command line will return with “1 found”. 
Hit ENTER to specify the height or path of the solid. Type “2.5” and ENTER for the height 
of the extrusion (Figure 8.24). The triangle will expand into a 3D prism as shown in Figure 
8.25. 
 
 
 

Aligning a Solid to the Master Solid 
________________________________________________________ 
 
Select the Align command by expanding the Modify panel. At the command, “select 
objects”, pick the prism hit ENTER to proceed to the second part of the function. 
Notice that this is not the 3D Align command. 

 

The first source and destination points will 
end up becoming the same point in the 
finished alignment.  In this case, select the 
midpoint Osnap of the longest side of the top 
face of the prism as the first source point and 
then the midpoint Osnap of the back edge of 
the top face of the master solid as the 
destination point.  These two points will join 
to become the same point when the alignment 
is finished.  A temporary line will appear on 
the screen showing the relationship of the two 
points (Figure 8.26).   

  
Figure 8.26 – First source and destination 
points 
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The second and third set of points you select 
will not end up becoming the same point, but 
they will reside on the same respective axes.  
For the second source point, select the left 
corner of the top face of the prism.  Select the 
top back right corner of the master solid as the 
destination point.  Again a temporary line will 
appear connecting both points, showing their 
relationship in the alignment (Figure 8.27).  
When finished with the command these two 
points will reside on the same parallel line.   

  

Figure 8.27 – Second source and 
destination points 

 

 

 

The third set of points will finalize the 
definition of the planes of the two shapes that 
you are aligning.  Select the 90 degree angle 
corner of the top face of the prism as the third 
source point.  Select the midpoint Osnap of 
the back bottom edge of the master solid as 
the third destination point (Figure 8.28). 
Immediately the prism will snap into 
alignment with the master solid (Figure 8.29).  
Again, the difficulty of the Align command 
lies not in its complexity as a tool but in 
properly identifying the source and 
destinations points necessary to create the 
desired alignment.  This complex technique 
will require some practice but it can be 
mastered.   

  
Figure 8.28 – Third source and destination 
points 

 

 
 
 

Subtracting 3D Solids from the Master Solid 
________________________________________________________ 
 
To remove the two solids from the master solid, select the Subtract tool on the Solid 
Editing panel. 
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The command line will prompt you to 
“Select solids and regions to subtract 
from”. Select the larger master solid and the 
system will respond with “1 found”.  Hit 
ENTER to proceed to the next step, which is 
to “Select solids and regions to subtract”. 
Pick the box and the prism and the command 
line will respond with “2 found” (Figure 
8.29).  Hit ENTER and the shape of the two 
solids will disappear from the master solid 
as shown in Figure 8.30.   

  

Figure 8.29 – Solids selected to be 
subtracted 

 

  

  

  

Hide the 3D Solid 
________________________________________________________ 
 
To view a more realistic image of Solid Problem Seven, select the Hide command 
from the Visual Styles panel under the View tab (Figure 8.30). 
 

If you wish to return the graphical display to 
the previous, then choose the 2D Wireframe 
visual style on the View panel under the 
Home tab.  The solid part will return to the 
previous appearance. This command does not 
alter the mass of the solid or any of the 
dimensions, but is available for the computer 
aided designer as a viewing option. 

  

Figure 8.30 – The Hidden visual style  

  
  
  

Moving the Solid to the Origin Point 
________________________________________________________ 
 
To move Problem Seven to the drawing origin of 0,0,0 on the x, y and z axis, select the Move 
tool from the Modify panel under the Home tab, select the 3D solid, and hit ENTER.  At the 
prompt “specify base point or displacement,” select the bottom left endpoint Osnap as shown 
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in Figure 8.31, which will become its insertion point into an assembly drawing.  At the 
“second point of displacement,” type 0,0,0 and ENTER, or #0,0,0 and ENTER if using 
Dynamic Input. Problem Seven will move to the origin point.  Moving a part at the origin is 
important for when you wish to insert the solid into an External Referenced Assembly 
drawing. 
 

 
Figure 8.31 – Moving the finished solid to the origin 
 
 
 

Saving the Solid Problem 
________________________________________________________ 
 
To save Problem 7 in your Fundamentals of 3D Drawing Folder, select the Save As 
tool on the Quick Access toolbar. The Save Drawing As window will appear in your 
graphical display. In the Save In list box, select your drawing folder.  Type “Problem 
7” in the File Name textbox and hit the Save button to save the drawing (Figure 8.32). 
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Figure 8.32 – Saving Problem Seven 
 
* World Class CAD Challenge 03-07 * - Close this drawing file.  Create a New file and 
draw the solid using the techniques in this chapter. Move the finished solid to the origin 
of the drawing.  Complete the task in less than 5 minutes.  Continue this drill four times, 
each time completing the drawing in less than 5 minutes to maintain your World Class 
ranking.   
 
* World Class CAD Challenge * - Report your best times to World Class CAD at 
www.worldclasscad.com to obtain your world class ranking. 
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